
Whole of Government 
Accounts (WGA): 
Local Authority Guidance 2015-16

May 2016





Whole of Government 
Accounts (WGA): 
Local Authority Guidance 2015-16

May 2016



 

 

  

Whole of Government Accounts (WGA) - Local Authority Guidance 2015-16 1 

Contents 
 
 Page 

Chapter 1 Introduction 3 

Chapter 2 Submission Process and Timetable 5 

Chapter 3 Getting started on your DCT 11 

Chapter 4 Completing the DCT (stage 1 ) 13 

Chapter 5 Completing the DCT (Stage 2: counterparty data) 19 

Annex A Changing the macro settings in Excel 23 

 
 





 

 

  

Whole of Government Accounts (WGA) - Local Authority Guidance 2015-16 3 

1 Introduction 
 

1.1 The Whole of Government Accounts (WGA) are prepared by HM Treasury in accordance 

with the Government Resources and Accounts Act 2000. These financial statements consolidate 

more than 6,000 entities that appear to HM Treasury to exercise functions of a public nature or 

to be entirely or substantially funded from public money, and as such includes central 

government departments, non-departmental public bodies, public corporations, local 

authorities, the National Health Service and the devolved administrations. 

1.2 The challenging timetable, in conjunction with the wider faster closing agenda, will require 

each WGA body to review their processes for both their statutory accounts and WGA returns to 

integrate these wherever possible. 

1.3 WGA entities were able to meet the tighter deadlines for 2014-15 as they were more 

familiar with the Data Collection Tool (DCT) that had been introduced the year before. There will 

be minor changes made to the DCT for 2015-16.The DCT provides an efficient means of 

collecting high quality data from entities that ensures the following: 

 speeds up the consolidation process by including opening year balances 

 improves data quality by carrying out data validation checks 

 tracking of counter-party transactions 

 protecting data from unauthorised changes during the preparation and submission 

stages 

1.4 The external auditors of a local government entity have a statutory responsibility to review 

and report on the Whole of Government Accounts return (the Data Collection Tool) prior to the 

issue of the audit certificate.  
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2 
Submission Process and 
Timetable 

 

2.1 HM Treasury have now issues the template version of the Data Collection Tool (with macros) 

on the GOV website. WGA entities will use the DCT to create their entity-specific version in 

which they enter their 2015-16 data. Please contact if you have problems creating your entity-

specific version of the Data Collection Tool (DCT).   

2.2 Local government entities should ensure that the data in their completed DCT reconciles to 

their unaudited Statement of Accounts (Cycle 1 stage) and then to their audited Statement of 

Accounts following any input from their auditor (Cycle 2 stage) where the entity is above the 

WGA audit threshold.  

2.3 The DCT return is only valid if the built-in macros are intact and operational and it has been 

through the locking process when submitted to the auditor and HM Treasury (The e-mail 

address is LG_WGAreturns@HMTreasury.gsi.gov.uk). Please do not sent any more e-mails to 

DCLG. The process has changed, and all e-mails should now be directed to the LG HMT inbox. 

2.4 The DCT must be saved as an Excel 97-2003 workbook with a ‘XLS’ extension with the name 

of the entity in the DCT title. Please do not save it as an ‘xlsm’ file as the macros will not work. 

2.5 HM Treasury haven now issued a blank proforma template of the DCT without macros for 

English and Scottish local authorities on the GOV website (see 

https://www.gov.uk/government/publications/whole-of-government-accounts-2015-to-2016-

guidance-for-preparers).This template is for information only and must not be used for your 

WGA submission to HM Treasury. 

2.6 The main requirements for the Cycle 1 stage (unaudited) are set out in the diagram below. 

 

https://www.gov.uk/government/publications/whole-of-government-accounts-2015-to-2016-guidance-for-preparers
https://www.gov.uk/government/publications/whole-of-government-accounts-2015-to-2016-guidance-for-preparers


 

 

  

6 Whole of Government Accounts (WGA) - Local Authority Guidance 2015-16 

 

2.7 Where the DCT preparer anticipates that they cannot submit their Cycle 1 or Cycle 2 DCT by 

the published WGA deadlines then they must contact HM Treasury (via the WGA email account 

LG_WGAreturns@HMTreasury.gsi.gov.uk) as soon as possible and give an explanation for the 

delay and the date when they will submit the DCT. This information is used by HM Treasury to 

manage the overall production of the consolidated WGA accounts, and they may decide to 

publish a list of authorities that failed to meet the WGA deadlines.  

2.8 All local government sector entities are required to submit a second DCT (Cycle 2 DCT) 

regardless of the extent of the work carried out by the local auditor. The Cycle 2 return will be 

the Cycle 1 Data Collection Tool pack updated for the following: 

 Adjustments required by the auditor; and 

 Other adjustments e.g. amendments to counter-party data following the release of 

counter-party mismatches reports based on Cycle 1 DCT returns. 

2.9 The WGA entity should ensure that their local auditor and HM Treasury each receive the 

relevant WGA documents as set out in the diagram below: 

Cycle 1 (Unaudited DCT) – Due 12 August 2016 
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Cycle 2 (Audited DCT) – Due 21 October 2016 
 

 

 

2.10 HM Treasury is responsible for setting the WGA timetable deadlines. For 2015-16 the Cycle 

1 DCT has to be submitted by 12 August 2016 and the Cycle 2 DCT by 21 October 2016.  Please 

submit the DCT together with your Statement of Accounts (unaudited and the final audited 

version) to the HMT email box LG_WGAreturns@HMTreasury.gsi.gov.uk. 

 

Audit threshold limit 

2.11 If the DCT data is equal to or above the audit threshold limit, the cycle 2 DCT is locked at 

step 7 by the WGA entity and by the auditor at step 8, before being sent to the HM Treasury 

2.12 If the DCT data is below the audit threshold limit: 

 Cycle 2 is locked at step 7 by the WGA entity 

 E-mail the cycle 2 DCT to HM Treasury without locking at Step 8.  

Cycle 1 and Cycle 2 DCTs 

2.13 Progression through the Cycle 1 and Cycle 2 stages is dependent on the WGA entity 

satisfying the validation tests associated with each macro buttons on the Instructions worksheet 

of the DCT. The diagram on the following page gives an overview of each stage. 

Highways Infrastructure Assets 

2.14 The section on Highways infrastructure assets will not change for 2015-16. The purpose of 

this section is to build a picture of the value of the assets that will be brought on to the WGA 

balance sheet in 2016-17. 
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Cycle 1 Stage (Unaudited) – Due 12 August 2016
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Cycle 2 Stage (Audited) – Due 21 October 2016 
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3 
Getting started on your 
DCT 

 

3.1 WGA documents have been released online by HM Treasury at: 

https://www.gov.uk/government/publications/whole-of-government-accounts-2015-to-2016-

guidance-for-preparers. We recommend you download the master DCT from the website to 

ensure you have the latest version.  

3.2  The other WGA documents relevant to local government bodies are (a) Management 

Review checklist; (b) the 2015-16 Counterparty (CPID) list; (c) List of OSCAR account codes under 

each match relationship; and (d) the Bridging Tool, if you choose to use it. 

3.3 The master DCT template is for both central and local government entities. The correct 

version will be created once you enter your unique counterparty (CPID) code as follows: 

 

 

https://www.gov.uk/government/publications/whole-of-government-accounts-2015-to-2016-guidance-for-preparers
https://www.gov.uk/government/publications/whole-of-government-accounts-2015-to-2016-guidance-for-preparers
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4 
Completing the DCT (stage 
1 ) 

 

4.1 The DCT should be completed using the figures from the Group Statement of Accounts (if 

they are prepared) or from the single-entity Statement of Accounts (if group accounts are not 

prepared).  

4.2 The DCT is comprised of (a) template worksheets that broadly replicate the format of local 

authority statutory accounts, and (b) additional information worksheets to capture other details 

required for the production of the consolidated WGA accounts. The diagram below lists the 

worksheets in the DCT for a local government entity.  
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Completing the worksheets 

4.3 Data entry in the DCT is a two-step process.  

 First, populate the template worksheets so that a trial balance can be compiled. The 

trial balance figures will be analysed using the HM Treasury Standard Chart of 

Accounts (SCOA) codes.  

 Once this data has been validated and a CPID input sheet has been created in stage 

4, the second step is to enter the balances and transaction data with another WGA 

entity on the i.CPID_Transactions worksheet. This counterparty data is then used to 

calculate the consolidation adjustments needed by HM Treasury in the consolidated 

WGA accounts. 

4.4 Unless specified  otherwise, the DCT preparer is required to adhere to the following 

convention when entering data in the DCT: 

 amounts to be in £ thousands e.g. enter £5,000.00 as 5 

 only enter whole numbers i.e. no decimal places 

 no special characters to be used i.e. £, %, commas etc 

 use capitals when entering counterparty (CPID) codes e.g. enter COM085 but do 

not enter Com085 or com085 

 input in white/blue cells only 

4.5 Please use the comments boxes provided on each sheet. Where a number is made up of 

several figures or a balance was not agreed with another entity, please explain in comments 

boxes. HM Treasury uses these comments boxes to determine adjustments. If figures are 

explained, it will also reduce the need for HM Treasury to contact you during the preparation of 

accounts. 

4.6 Whilst the DCT worksheets (excluding the i.CPID_Transactions worksheet) can be completed 

in any order, it is recommended to complete the sheets from left to right (LP-Liabilities & Provs 

to LP-Add info – Transferred debt).  If you have restatements, start on the LP-Restatement CI&E 

sheet. See diagram below. 

4.7 Please be aware that for the devolved administrations, less information may be required. 

Please contact your relevant government (Scottish, Welsh, Northern Irish) for information. 
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5 
Completing the DCT (Stage 
2: counterparty data) 

 

Introduction 

5.1 Once the DCT has been validated at Step 2, the next step is to create the CPID input sheet in 

Step 3 (i.CPID_Transactions), and record the counterparty data with other WGA bodies. This 

data is used by HM Treasury to calculate the consolidation elimination adjustments to produce 

the WGA consolidated statements.  

Entering the counterparty data 

5.2 Each counterparty data item will comprise of three elements which are recorded together on 

the same row within the i.CPID_Transaction worksheet as follows: 

 Your WGA counterparty (CPID) code 

Enter your WGA CPID code on each row of column K where counterparty data has 

been entered (the name of your entity will then appear in column L). 

Do not add your CPID code to rows having no counterparty data as this will prevent 

the locking of your DCT.  

 

Your WGA CPID is the code selected in cell I5 of the DCT Instruction worksheet.  

 

 Your counterparty amount with the other WGA body 

Amounts are entered to the nearest whole £ thousands in column O against the 

appropriate Account code. 
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Each Account code has been allocated three rows, but additional rows can be added by 

using the ‘Add CPID Rows’ macro button at the top of the i.CPID_Transactions 

worksheet (or deleted using the ‘Delete Selected Rows’ macro button).  

Column P gives the total of your counterparty data for each Account code, and this 

amount cannot exceed the amount in column J.  

Where the ‘Status’ warning in column R appears Red then the counterparty data has to 

be corrected, or if the warning is Amber then an explanation has to be entered in 

column U.  

 The CPID code of the other WGA entity 

A list of the WGA entities and their CPID codes can be found on the CPID_List worksheet 

of the DCT. The counterparty CPID code has to be entered in column M each 

counterparty amount (the name of the counterparty will then appear in column N).  

 

Do not add the counterparty CPID code to rows having no counterparty data as this will 

prevent the locking of your DCT. 

If you have several counterparty amounts against the same counterparty CPID code and 

the same Account code, then please aggregate the counterparty amounts and enter this 

amount on a single data line against the Account code. 

Other matters to consider 

5.3 The table below sets out topics affecting your counterparty data. 

Using the correct CPID codes Academies – use CPID code CAD022 (do not use 

Department of Education’s CPID code DFE022); 

Scottish FE Colleges: Use CPID code SFE075  

HM Revenue and Customs – use CPID code IRT813 

for transactions related to taxes and duties (use 

HMR041 for other transaction types); 

PWLB loan borrowings – use CPID code PWL888 

(do not use NLF888); 

Debt Management Account Deposit Facility 

(DMADF) – lending to HM Government via 

Treasury bills and UK Government sterling 

denominated listed bonds (gilt-edged securities or 

gilts) – use CPID code DMA888. 

GOV website (WGA webpage for 2015-16) – 

https://www.gov.uk/government/publications/who

le-of-government-accounts-2015-to-2016-

guidance-for-preparers 
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Useful web links Structure of NHS bodies – see page 8 of the pdf 

leaflet - http://www.england.nhs.uk/wp-

content/uploads/2014/06/simple-nhs-guide.pdf 

Threshold limit for counterparty data HM Treasury has removed the £1 million threshold 

for counterparty disclosure requirement to allow 

authorities to disclose transactions below this level 

if a more appropriate materiality threshold at local 

level can be applied and if your systems and 

processes allow you to extract this level of 

information. 

The intention is that this should not result in 

additional labour-intensive analyses. 

If you have the information, please put it in the 

DCT as this greatly reduces HM Treasury’s un-

eliminated error. 

Government grants and contributions Revenue and capital government grants and 

contributions received and recognised in the I&E 

statement should be analysed fully and allocated 

to the CPID code of the grantor. 

Revenue and capital grants and contributions that 

are received during the financial year, but are 

credited to the Receipts in Advance should also be 

fully analysed and allocated to the CPIS code of 

the grantor. 

Grants and contributions received in prior years 

and released to the I&E statement of the current 

reporting year do not have to be allocated to a 

CPID code. 

 

 

 

 

 

 

http://www.england.nhs.uk/wp-content/uploads/2014/06/simple-nhs-guide.pdf
http://www.england.nhs.uk/wp-content/uploads/2014/06/simple-nhs-guide.pdf
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A 
Changing the macro 
settings in Excel 

 

A.1 This annex explains how you can change the macro parameters for each version of Excel 

before using the DCT. 

 

Excel 2003  

Open the security dialog box 
using the Tools menu and 
select the Macro option 
followed by the Security 
option. 

 

In the Security dialog box, 
select the Trusted Publishers 
tab, and tick the ‘Trust Access 
to Visual Basic’ box before 
closing the dialog box by 
clicking the ‘OK’ button 

 

Excel 2007  

Select the Microsoft Office 
button (1) to open the Excel 
Options menu (2). 
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Select the Trust Center dialog 
box (3), followed by the Trust 
Center Settings (4) then the 
Macro Settings option (5). 
Choose the ‘Enable all macros’ 
(6) and also the ‘Trust access 
to the VBA project object 
model’ checkbox (7) before 
selecting the ‘OK’ button. 

 

Excel 2010  

Select the File tab (1) followed 
by Options (2). 

 

Then choose the Trust Center 
option (3), followed by the 
Trust Center Settings button 
(4) followed by the Macro 
settings option (5). Tick the 
‘Trust access to the VBA 
project object model’ box (6) 
and close clicking the ‘OK’ 
button (7). 

 

Excel 2013  
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Select ‘File’ Tab, followed by 
Options 

 

Select ‘ Customized Ribbon’ 
and ensure Developer is 
highlighted so it creates the 
Developer tab 
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Open the ‘Developer’ tab. 
Under visual basics, go to tools 
 references. Ensure the 
following libraries are 
activated: 
 
1. Visual Basic for Applications 
2. Microsoft Excel 14.0 Object 
Library 
3. OLE Automation 
4. Microsoft Office 14.0 Object 
Library 
5. Microsoft ActiveX Data 
Objects 2.8 Library 
6. Mucrosoft ActiveX Data 
Objects Recordset 2.8 Library 

 

 

In the Developer tab, under 
Add-ins, select Analysis 
ToolPak and Analysis ToolPak - 
VBA 

 

Finally, under options, go to 
Trust Centre, and then macro 
settings. You must enable 
Trust access to the VBA project 
object Model 
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